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TRY BEFORE YOU BUY SOFTWARE

This is try-before-you-buy software.  This means you can try this
software to find out whether it provides what you need before you
pay for it.  There are no limits in this software nor is it
crippled in any way.  It is true "try before you buy" software.  

You may have obtained this software from a shareware disk vendor,
a bulletin board or a friend.  I hope you also feel free to share
copies of it with your friends and upload it to your favorite
bulletin board(s).  If you find you like this software and you've
been using it for more than 60 days, you must register as a user
by purchasing a registered copy.  This software may not be used
for more than 60 days without registering.

Registration Information

This is a copyrighted software program protected by both U.S. and
international copyright law.  If you are using this software for
more than 60 days you must purchase a registered copy in order to
continue to use it.  The registration for a single copy is $59.95
(plus $6.00 S&H - $10.00 outside North America).  Please note
that even though you may have purchased this disk from a retail
store or via mail order, you have not purchased a registered
copy. What you've paid for this disk was a fee that compensates
the vendor for their costs, time and effort in making this disk
available.

We accept company checks, personal checks, VISA, Master Card, and
American Express.  All amounts shown are in U.S. dollars.  All
checks in U.S. dollars must be drawn on a U.S. bank.  Users
outside the U.S.:  You may purchase a copy of the OYC: Multimedia
software from any of the distributors listed on the order form
(ORDER.FRM file).  Or you may order direct from PSG-HomeCraft
Software--we accept cheques in your local currency from
users in Canada, Mexico, Australia, the United Kingdom, New
Zealand, Sweden, Norway, France, Germany, Denmark, The
Netherlands, Japan and Switzerland.  We will add other countries
as our bank allows.

You can register as a user via Compuserve by sending an E-Mail
with the appropriate information (or E-Mailing the ORDERFRM.TXT
file) to ID 71450,254.

When you register you will receive:

[]  The current version of this software.  We are constantly
making improvements and adding features suggested by users.  We
do not duplicate your disk until just before we ship the
registered version of your software, thus you get the very latest
version and newest features.



[] Addition features not available in the shareware version. 
Plus additional utilities we have developed for use with OYC.

[] Information about easy ways to get pictures in your computer,
and thus into OYC, without using a scanner.

[]  A copy of the illustrated, printed and bound manual.  (Being
able to refer to a printed manual as you are using the software
makes using the software easier.)

[] One year free, unlimited technical support via telephone,
fax, mail or electronic mail.

[] A free subscription to our newsletter which includes user
tips, help with using your computer, information about upgrades
and new cataloging systems.

[] Additional cataloging formats including: music, books, video
games, video tapes, home inventory, stamps, coins, comic books,
sports cards, plants and garden, memorabilia, model railroad (2
formats), art, fabrics & notions, tokens, guns, photographs, and
more.

[] The ability to use your own custom designed screen as the OYC
opening screen.

MULTIPLE COMPUTERS AND NETWORKS

If you wish to use this software on a network or simultaneously
on more than one computer (eg. on a computer at home and
another computer at work or in the office of a charity), you
will need a site license.  Please contact PSG-HomeCraft, or any
of our distributors, for additional information about site
licenses.

DISTRIBUTION OF THE SHAREWARE VERSION OF THIS SOFTWARE

(Please see the VENDOR.DOC file).

Please feel free to give away copies of the shareware version of
this software to friends, relatives, acquaintances or even
strangers, as long as no fee is charged.

OUR GUARANTEE

If you have any problems with this program or the disk it is on,
without regard to where you obtained it, you may send it to
PSG-HomeCraft Software for a free update to the current version.
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SPECIALTY  DATABASE    
U S E R   L I C E N S E   A G R E E M E N T
NOTICE! - This manual and the enclosed software is provided to
you on the express condition that you agree to this software
license.  By using this software you agree to the following
provisions.  If you do not agree with these, please return these
materials for a full refund.

<1> This manual, the enclosed software and the disks on which it
is contained are licensed to you, for your own use only.  This is
copyrighted software.  You are not obtaining title to the
software or any copyright rights.  You may not sublicense, rent,
lease, convey, modify, translate, convert to another programming
language, decompile, or disassemble the software for any purpose.

<2> You may make as many copies of this software as you need for
backup purposes.  Private individuals may use this software on up
to two computers, provided there is no chance it will be used
simultaneously on more than one computer.  This software may not
be used simultaneously on more than one computer, nor installed
on more than one hard disk, nor installed on a network used by a
business, corporation, government agency or department, or
institution of any kind.  If you need to install this software on
more than one computer or on a network, please contact us for
information about a site license.

WARRANTY - HCP SERVICES INC. DISCLAIMS ALL WARRANTIES RELATING TO
THIS SOFTWARE, WHETHER EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE, AND ALL SUCH WARRANTIES ARE EXPRESSLY
AND SPECIFICALLY DISCLAIMED.  NEITHER HCP SERVICES, INC. NOR
ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR
DELIVERY OF THIS SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT,
CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE SUCH SOFTWARE EVEN IF HCP SERVICES, INC. HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIMS.  IN NO
EVENT SHALL HCP SERVICES, INC.'s LIABILITY FOR ANY DAMAGES EVER
EXCEED THE PRICE PAID FOR THE LICENSE TO USE THE SOFTWARE,
REGARDLESS OF THE FORM OF CLAIM.  THE PERSON USING THE SOFTWARE
BEARS ALL RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE.
Some states do not allow the exclusion of the limit of liability
for consequential or incidental damages, so the above limitation
may not apply to you.

This agreement shall be governed by the laws of the State of
Oregon and shall inure to the benefit of HCP Services, Inc. and
any successors, administrators, heirs and assigns.  Any action or
proceeding brought by either party against the other arising out
of or related to this agreement shall be brought only in a STATE
or FEDERAL COURT of competent jurisdiction located in Multnomah
County, Oregon.  The parties hereby consent to in personam
jurisdiction of said courts."
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SECTION ONE  
INTRODUCTION

PSG-HomeCraft's ORGANIZE! Your Collection: Multimedia software is
a quick and easy-to-use database/cataloging program designed
specifically for organizing information about books and
magazines.  You can catalog your books, and any other printed
material, in as much detail as you wish--even to the extent of
cataloging individual chapters in books.

One of the ways I use this software is to help me keep track of
the various magazine articles I've read.  I used to often find
myself in a situation in which I'd remember reading something,
somewhere, in some magazine, but I couldn't find it.  Now when I
read an article I find interesting or useful, I tear it out;
number it; catalog it using the ORGANIZE! software; and then file
it.  I've been doing this for the past five years, and in that
time I've been able to quickly find every article I've needed.  

I also use the ORGANIZE! software in a similar manner for my
books.  Most of my books are fiction and science fiction, and
they cataloged in the normal manner, with one entry for each
book.  However, when I catalog an anthology I catalog each story
separately.  That way I can search for and find every book and
story by a specific author or about a specific subject.  I also
have quite a few history books and many of those are cataloged by
chapter.  Each chapter is entered in my OYC catalog allowing me
to search for a subject and imediately find the books, and
chapters in those books, that cover that subject.

I have to admit that it's fun--really fun--to almost instantly
find the book or magazine I'm looking for, instead of spending
half a day trying to remember which book I want and then find it
on my shelves.

SYSTEM REQUIREMENTS: this software requires an IBM compatible
computer running Windows version 3.1 or later.  A hard disk is
required.

USING THIS MANUAL

This manual is divided into three main sections plus appendixes. 
You are reading section one now.  It contains the introductory
information and it also includes a short, two page set of
instructions for those of you who can't wait to give ORGANIZE! a
try.  Section two provides more detailed instructions to help you
start using the software as soon as possible. 
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The third section is a "how-to" section providing step-by-step
instructions for the most commonly used features in ORGANIZE!

USING EXISTING DATA FILES

The Windows version of ORGANIZE! can not directly use files
created by all previous versions of the DOS version of OYC.  If
you have files created by the DOS version, or another of
HomeCraft's programs such as "Book Minder", "For Record
Collectors", or "Home Insurance",  you need to either get the
registered version of this software, or download a conversion
utility from the "ORGANIZE! Everything... BBS" by calling (503)
692-0382.

Please note: the registered version of "OYC In Windows" can
directly read OYC DOS version 5 and 6 files, and it can convert
files created by versions older than 5.0.

At HomeCraft a standard we maintain (for registered users), above
all else, is that: we will never make a change in our software
that results in your having to retype your catalog.  If we do
need to change the data format, all registered users of the new
version will be supplied with a free conversion utility.  We know
that the information in your catalog is very important and took a
lot of work to compile--we'll do everything we can to insure you
never have to type it again.

If you have your collection cataloged using a database program
that can create dBase III files, ORGANIZE! will directly import
those files.  All you need to do is select the "Import dBase"
option on the Catalog Maintenance window.  There are specific
instructions on how to import dBase III files in the second
section of this manual.

TECHNICAL SUPPORT: If you have problems using the ORGANIZE!
software, please read the entire manual first.  Appendix A
provides a trouble shooting guide that may be helpful in solving
problems.  If you are unable to solve the problem by reading the
manual, feel free to give us a call.  The number is 1-503-
692-3732.  Limited technical support for shareware users is
generally available from 9am till 5pm Pacific time monday through
friday.  When you call, please be near your computer and have it
turned on.

You may also contact us via Compuserve at ID number 71450,254; or
by fax at 1-503-692-0382.  

You can contact me directly, for technical support or with
questions, by writing to:
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Steve Hudgik, President - PSG-HomeCraft
P.O. Box 974
Tualatin, OR 97062  U.S.A.

MAKE BACK UP COPIES

The most important suggestion I can pass on is to ask that you
make sure to make back-up copies of your data files (the ones
that end with DAT).  If you have a hard disk I recommend using
software such as FastBack or PC Tools.  Any time you have typed
more entries than you'd want to type again, you  should backup up
your catalog.

Anytime you are going to defragment your hard disk; install a new
program; or modify and OYC catalog, first be sure you have a
current backup copy of your OYC catalog(s).

GETTING STARTED - SHORT CUT

For those of you who want to get started right away, here is a
very short summary of how to use the ORGANIZE! software.  In this
"short-cut" summary I have assumed you have a basic knowledge of
computers and Windows.  If you are unfamiliar with Windows or
computers, you may want to skip this section as it could make
things appear to be confusing.

After installing ORGANIZE! its icon will appear as a part of the
"Main" program group in the Program Manager.  You can move the
icon to another group by clicking on the "OYC" icon and dragging
it into the program group where you'd like it to be permanently
located.

When you start ORGANIZE! for the first time it will be set to use
the "BOOKS" format.  We have also included a catalog format
designed specifically for professional books.  If you want to
switch to another catalog pull down the File Menu and click on
"Catalog Maintenance".   When the "Catalog Maintenance window is
displayed you will see a box on the lower left side that displays
a list of all of the catalogs you've installed.  Double click on
the one you want to use.  Then click on the "OK" button to return
to the Main Screen.

You can use the catalogs we've included way we've designed them,
however most people like to customize them to specifically fit
what they want to do.  In most cases you will not need all of the
fields, or you may want to add some other fields.  To change the
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catalog format go back to the "Catalog Maintenance" window and
click on the "Change Format" button.  This will display a screen
on which the field names and lengths can be changed.  Setting a
field length to zero removes that field from the catalog format.

The "Catalog Setup" window is also used to mark the fields to be
alphabetized or totalled.  Marking a field with the "key" symbol
sets it to be alphabetized.  I recommend that you not alphabetize
more than four or five fields at one time.  Each field that is
marked to be alphabetized results in the creation of index files,
which can use a significant amount of disk space.

Once the catalog is set up the way you want it to be, you can
start entering information about your collection.  Just fill in
the blanks and click on the "Save" button at the top of the
screen.  Anytime you push "F5" then entry displayed on the screen
will be saved.  Each time you save a new entry, a new blank
screen will appear, ready for another entry to be typed.

For additional "quick start" information about using OYC For
Windows read the help screens provided in the software.  

Customizing OYC: Multimedia

When OYC starts it plays a short piece of music.  You can change
this music, or eliminate it.  The music is stored in the
OYCOPEN.WAV file.  If you erase this file, no music will be
played when OYC starts.  If you record something else and store
it as a "WAV" file named "OYCOPEN.WAV" this will replace the
existing music with the new music you've recorded.  The new
OYCOPEN.WAV file must be placed in the same directory as the
OYC.EXE file.

Multimedia Features:

OYC has been designed to make creating a multimedia catalog very
easy.  You may attach both a picture and a sound file to any
entry in your catalog.  The same picture and sound files may be
attached to as many entries as you wish.

Sound files may be any Windows WAV file.  Picture files must be
BMP images that are no larger than 640 X 480 - 256 colors.

To attach a sound or image to an entry go to the "Edit Menu" and
select the "Picture/Sound" option.  Enter the names of the WAV
and BMP files, including the filename extensions, in the
appropriate boxes and click on "OK".  Please note that the BMP
and WAV files MUST BE in the same directory as the OYC software.
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SECTION TWO
SOFTWARE REFERENCE

This section provides information about using each of the
features in ORGANIZE! Your Collection For Windows.

THE MAIN SCREEN

The Main Screen has five different areas:

1) The line across the top of the screen identifies the software
and the version number.  It also includes the three standard
Windows symbols:  a minus sign in the upper left corner, and
up/down arrows in the upper right corner.  These are used to
control the size and position of the Main Screen.  For
information describing how these controls work please see
Appendix B, Using Windows.

2) The second line from the top of the screen is a menu bar. 
We'll discuss each menu and menu selection shortly.

3) The third line from the top provides a series of push buttons. 
These buttons provide direct access to the most commonly used OYC
features.  Each push button will be discussed when the
corresponding menu selection is discussed.

4) The center area of the screen is used to display and enter
information about your collection.

5) At the bottom of the screen there are a series of status
displays (see figure 2). These show, from left to right: the
current entry number being displayed; the name of the current
catalog in use; the entry status--whether the entry is deleted or
has a memo attached to it; whether the catalog is sorted or
unsorted; where the results of a search or listing will be
displayed; and the current mode (ie. Make Entries, Edit, Search,
etc.) the software is in.  I'll explain the information shown
here in greater detail as we go along.



__________________ORGANIZE! Your Collection In Windows - 6

THE FILE MENU

Put the mouse cursor on the word "File" (it's the left-most
selection on the menu bar at the top of the screen) and click
once.  This will display the File Menu.  You can also display the
File Menu by holding down the ALT key and pushing the letter "F".

There are only two selections on the File Menu: Catalog
Maintenance and Exit.  Select "Exit" when you are done using OYC
and wish to exit from the software.

The Catalog Maintenance option provides a variety of features
related to the catalogs such as: switching between various
catalogs; designing a new catalog; renaming catalogs; and
backing-up a catalog onto a floppy disk.  Go ahead and select the
Catalog Maintenance option (use the mouse to click on it) on the
Files Menu.  This will display the Catalog Maintenance window. 
I'll discuss each of the features in this window.

Picking A Catalog To Use

The Catalog Maintenance window is shown in figure 3 and the next
page). The left side of the Catalog Maintenance window is used to
select the catalog you want to use.  Catalogs can be stored on
any drive and in any directory, although I suggest keeping all of
your OYC files together by storing the catalog files in the same
directory as the OYC program.

The top box on the left side of the window shows the drive, path,
and directory where the current catalog in use is located.  To
select a different disk drive use the mouse to click on the down
arrow that is on the left side of the upper box. In figure 3 this
box contains the words "c:[VOLUME 1]".  This will pull down a
list of the available drives on your computer.  Click on the
letter for the drive you want to use.

The path display, below the box you just used to select a drive,
will change to show the current path and directory on the drive
you just selected.  (If you are not familiar with these terms,
see the Appendix B in the Installation & Formats manual for
information about paths, directories, and filenames).  Use the
mouse cursor and double-click on the directory you want to use. 
If the directory is not shown, double-click on the root directory 
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(which just has a the drive letter, a colon, and a backslash) to
see a listing of all directories.  If there are more directories
than can be displayed in this box, a slider will appear on the
right side of the box.  Use the mouse to move this slider up and
down to see other parts of the list of directories.

The box in the lower-center of the left side of the Catalog
Maintenance window lists the names of the available OYC catalogs
in the selected directory, and it shows the number of entries in
each catalog.  The catalog currently being used is shown at the
bottom of this window.

The right side of the Catalog Maintenance window has a vertical
line of push buttons.  Here's a brief description of what each
does:

Change Format: used to modify the format of the current catalog.

New: used to start a completely new catalog format.

Rename: This button is used to change the name of the current
catalog.

Delete: lets you delete a catalog so that it is no longer on the
disk.

Backup: runs the OYC backup utility that will compress the
catalog files onto a floppy disk.

Reserve Space: is used to set aside space for future entries in
the catalog.

Import DBase: converts DBase III files to the data format used by
OYC.

Select: is used to select the catalog you want to use.

OK: Click on the button to close and exit from the Catalog
Maintenance window.

I'll cover each of these starting with the most frequently used.
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Selecting A Catalog

To get OYC to switch to another existing catalog, go to the
Catalog Maintenance window.  In the box displaying the list of
catalogs, use the mouse cursor to double-click on the name of the
catalog you want to use.  The blue scroll-bar will highlight that
catalog's name and a light yellow border will appear around the
outer edge of the scroll-bar. Next click on the "Select" push
button and the highlighted catalog will become the current
catalog.

You can now click on the "OK" button to leave the Catalog
Maintenance window and return to the Main Screen.  The format for
the newly selected catalog will then be displayed on the Main
Screen.

It is possible that files created by other programs will be
listed as OYC catalogs.  Should this happen, the number of
entries for that catalog will be zero.  If you try to select a
non-OYC file, you will get an error message that says, "The
default catalog is invalid or missing. No catalog selected."

Starting/Designing A New Catalog

To start a new catalog go to the Catalog Maintenance window and
use the mouse to click on the "New" button.  A window titled "New
Catalog" will open.  Enter the name you want to use for the new
catalog.  Catalog names must be valid DOS filenames. They may
have up to eight characters and they may not contain punctuation
or blank spaces.  Then either press ENTER or click on the "OK"
button.

The easiest way to start a new catalog is to copy the format from
an existing catalog, if there is one that is similar to what you
want in the new catalog.  The next prompt you see on the screen
asks whether you like to use the format of the highlighted
catalog, and copy it to the new catalog you are creating.  Notice
the format of the highlighted catalog will be copied, not the
currently selected catalog.  This allows you to highlight any
catalog, picking the one that best serves as a good starting
point for your new catalog, without having to set the software to
use that catalog.
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You'll now be at the Catalog Setup window.  The name of the
catalog you are working on is shown in brackets at the top of the
window. There are four components of a catalog format that can be
changed: the names of the fields; the length of the fields; which
fields are to be alphabetized; and which fields are to be
totalled.

There are a total of 21 fields (lines) that can be used for
entering information about the items in your collection.  First
I'll describe how to set up a catalog format, then I'll talk
about how the software should be used for cataloging a
collection.  

Field Names

The field names are shown in a column on the left side of this
window.  Notice that there is a button that looks like a white
"circle" next to each field (see figure 4). The button that
contains a black dot indicates the line you are currently working
on.  To move the black dot to another circle, so you can work on
another line, put the mouse cursor on the line you want to work
on and click the left mouse button.

To change a field name, or enter a field name where none exists,
put the mouse cursor on the field name box where you want to
enter the new name and push the left mouse button.  A thin
vertical line will appear within that field name box.  You can
then type in the new field name.

Note: the software is always in the insert mode when typing field
names.  If there is already a name for the field, it will move to
the right as you type in the new name.  Push the delete key to
erase the existing field name.  Field names can be up to 14
characters in length.  If you are unable to type in a field name
that has 14 or less characters, then there is probably still some
of the previous field name left.  Push the DEL key to erase the
previous field name.

Note: You do not need to have a name for each field.

Field Lengths 

Fields can be anywhere from one character up to 64 characters in
length.  Fields whose lengths are set to zero will not appear as
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a part of the catalog format.  Thus, setting a field to a zero
length, "turns off" that field so it no longer exists.

Field lengths can be set in two ways.  The first way is to use
the "Add" and "Subtract" buttons on the right side of this
window. Clicking on the "Add" button adds one character to the
length of the field.  Clicking on the "Subtract" button reduces
the length of the field by one character.

The second way to set the field length is to click on the
"Length" box and then type in the number for the length of the
field.  

To give you a feel for the actual length of the field, a sample
field is shown at the bottom of the window.  This sample
graphically shows the length of the currently selected field.

Alphabetizing With Indexes (Key Fields)

The OYC software uses indexes to put information into
alphabetical order.  A computer uses an index in the same way an
index is used in a book.  In a book the index is an alphabetical
listing of the contents of a book.  If you want to find something
in the book quickly, you look it up in the index so you can go
directly to the correct page.  A computer index works the same
way.

A computer index is an alphabetical listing of the information in
a specific field.  If you want to quickly find something in your
catalog, the computer can use the index to immediately go to the
correct entry.  A computer index is also used to put a catalog
into alphabetical order, just like a book index puts the contents
of the book into alphabetical order.  Thus, if you want to put
your catalog in order by catalog number, you will need to set the
catalog number field to be indexed.

To select fields to be indexed first click on the field name, and
then click on the small box next to the word "Key" on the right
side of the window (you can also push ALT-K instead of using the
mouse).  The word "key" refers to the "key" words in an index.  A
key symbol will appear next to each field that has been set to be
indexed.  To stop a field from being indexed just repeat this
process and the "key" symbol will be removed.



__________________ORGANIZE! Your Collection In Windows - 11

I recommend that you not set more than four or five fields to be
indexed.  Each index uses additional disk space and will tend to
slow down the software.

Totalling Values In Fields

Fields can be set so that any numerical values entered in those
fields will be totalled.  This feature would be used, for
example, to get the total value (or total cost) of your
collection.  Any field that is marked to be totalled, will give a
total value at the end of every search or listing.  Only those
items included in the search or listing will be included in the
total.  Thus, for example, if you search for all of the items in
your collection that start with the letter "A", the total value
of those items will be shown at the end of that report.

To set a field to be totalled click on the small box next to the
word "Sum" on the right side of the window. An "X" will appear in
the box when the field is set to be totalled and a sum symbol (it
looks like an "M" turned on its side) will be displayed next to
the field.

Saving The Catalog Format

Once the catalog format has been set up the way you want it to
be, click on the "OK" button (or push ALT-O) to save the new
format and return to the Catalog Maintenance window.

Renaming A Catalog

You can change the name of a catalog using the "Rename" button on
the Catalog Maintenance window.  Click on the "Rename" button. 
You'll then be prompted to enter the new name for the catalog. 
The name must be a valid DOS filename.  This means you may enter
up to eight characters, except that punctuation characters and
spaces may not be used in catalog names.

Deleting A Catalog

If you no longer need a catalog, you can delete it from the disk. 
First click on the name of the catalog you wish to delete so that
the blue highlight bar moves to that catalog name.  Then click on 
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the "Delete" button.  You'll be asked to confirm that you really
wish to delete the selected catalog.  Click on "Yes" to delete
the catalog or "No" to return to the Catalog Maintenance window
without deleting the catalog.

Backing Up Your Catalog

Entering information into ORGANIZE! can take a lot of time and
it's not something most people want to do twice.  That's why
maintaining current backup copies of all your catalog files is
very important.  The backup button on the Catalog Maintenance
window provides a limited, but effective way to backup your
catalog files.

NOTE: this backup feature is not intended to be a complete hard
disk backup system.  I strongly recommend that you purchase
software such as PC Tools, Fastback, or any of the many other
backup utilities available.  We include this utility only because
a large number of users create catalogs having several thousand
entries and then lose them when their computers encounter a hard
disk problem.  This utility is only intended to be used while
your catalog is small and until you can purchase a normal backup
utility program.

The backup utility will backup the catalog currently in use.  The
name of this catalog is displayed at the top of the Main Screen. 
Each catalog must be backed up separately on separate floppy
disks.

To use the backup utility, click on the "Backup" button on the
Catalog Maintenance window.  Read the first screen that appears
and then push ENTER.  When the next screen appears, you can push
"E" to exit, "B" to start a backup, or "R" to recover backup
copies from a floppy disk.  On the next screen, push the letter
that identifies the disk drive containing the backup floppy disk.

You should start your backup using a blank formatted disk and you
must use a separate disk for each catalog.  The backup utility
will first erase the floppy disk before it starts to make the new
backup.  If you try to backup two catalogs onto the same floppy
disk, the first will be erased.

I suggest keeping a set of three backup disks for each catalog. 
Rotate through this set always using the oldest one for the 
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current backup.  For example, use disk #1 to make today's backup. 
Next week, when you make another backup copy, use disk #2.  The
third time you make a backup use disk #3.  Then when you backup
this catalog for the fourth time, use disk #1 again.  That way,
if your current backup should turn out to be bad or if it copied
files that were damaged just before the backup was made (it
happens a lot), you can go back to an older copy and still
recover most of your catalog.

NOTE: you do not need to erase or reformat backup floppies before
using them a second, third, forth, etc. time for the same
catalog.  The backup process will erase the previous backup files
on the floppy disk.  You only need to start with a blank floppy
when starting to back up a catalog that has never been backed up
before.  Each floppy disk should be used to backup just one
catalog -- even if there is free space on the floppy disk. 
Multiple catalogs can not be backed up to a single floppy disk.

Each backup disk should be labeled to show the catalog that was
backed up and the date the backup was made.

You can recover a backup copy by following essentially the same
sequence of steps.  Just push "R" for recover instead of "B" for
backup on the appropriate screen.

NOTE: When files are being recovered, the backup utility will not
allow a file with an older date to overwrite a more recent file. 
If you have lost a catalog and in looking for it have created
another catalog using the same name, the more recent catalog will
have to be erased before the backup utility will copy the old
files to your disk.  There is a selection of the Utilities Menu
that is used to delete catalogs.

The backup utility uses a utility file called LHA.  It is a
separate program that ORGANIZE! runs by shelling to DOS.  This
utility was written by Yoshi and is copyrighted 1991 by Yoshi. 
The documentation for the LHA utility is included on the disk in
a text file called LHA.DOC.  You may use this utility for other
things, such as transferring files between computers and
compressing files to save space on your hard disk.  I recommend
you read the documenta-tion  (Neither HomeCraft nor Yoshi provide
technical support for the LHA utility.)  Please note that LHA may
not be used with any software that uses copy protection.
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Reserve Space

The Reserve Space feature provides a way for you to set aside
space on your hard disk, and reserve that space for future
entries in your OYC catalog.
 
When you click on the "Reserve Space" button a window will open
and prompt you to enter the number of entries for which you want
to reserve space (see figure 4).  Estimate the total number of
entries you expect to have and enter that number.  However, if
you expect to have a large number of entries (greater than 1000
or so), you should not reserve space for more than 500 to 1000
new entries at one time.  Reserving too much space can result in
a lot of wasted disk space, if you later change your mind about
how many entries you'll be putting in the catalog.

Reserving space does not set a limit on the number of entries you
can have.  For example, if you reserve space for 100 entries, you
can still make as many entries as you wish.  The software will
fill the 100 reserved spaces and then continue on without any
problems.  If you do not wish to reserve any space, you do not
need to, as the software does not require that space be reserved.

The purpose of reserving space is two-fold.  First, if you expect
to have a lot of entries in your catalog, and you are using other
software on the same disk, the reserve space feature is used to
set aside disk space for use by ORGANIZE!.  This will insure the
disk space you want to use for your ORGANIZE! catalog is not used
up by files created by other software.   This feature is
primarily valuable when saving a catalog on a floppy disk.

The reserve space feature is also used to help prevent the
catalog file from becoming fragmented.  Fragmented files are a
normal result of using a computer.  When a computer stores
information on a disk, it puts that information into the next
available sector on the disk.  The next available sector may not
be physically located anywhere near the previous sectors the
computer was using.  As you add to a catalog file, it tends to be
broken into small pieces that are scattered in various sectors
all over the disk.

The problem with fragmented files is that they slow down your
computer because it takes more time for your disk drive to put 
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the pieces of a file together if it is scattered all over a disk. 
With serious file fragmentation the computer can actually lose
track of pieces of a file.  As a result the computer can become
"confused" and lock-up; you might begin getting strange results
for searches or be unable to access some entries.  (This will
happen with all types of programs.  I've had fragmented files
create problems with WordPerfect, Lotus 123 and Microsoft Works
files).

Reserving space helps prevent files from becoming fragmented.  If
you start by reserving space and then defragment your hard disk,
the ORGANIZE! catalog file will stay together in one piece
regardless of any other activity that affects the disk.  Notice
that I said you will need to defragment your hard disk.  How do
you de-fragment a disk?  You will need a utility that has been
designed to do that.  Take a look in Appendix A for a further
discussion of fragmented files and descriptions of several
utilities I recommend.

Import A dBase File

You can import the information contained in most dBase III files. 
To do this, click on the "Import dBase" button on the Catalog
Maintenance window.  This will open a window that is used to
select the dBase file you want to import.  The dBase file may be
on any drive and in any directory.  If the file you want is on
another disk drive, use the drop-down list box labeled "Drives"
to select the correct drive.  If the dBase file is in a different
directory, use the "Directory" box to select another directory.

The next window contains a prompt asking you to enter a name for
the new catalog that will be created.  You must enter a valid
eight-character DOS filename, and the name may not already be in
use.  The next window displays the name of the selected dBase
file and shows how many records (entries) it contains. Click on
the "OK" button to copy the information in the dBase file to the
new OYC catalog.

NOTE: this utility will only copy non-relational dBase files. 
Relational dBase files can not be imported into ORGANIZE!.
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The "Select" Button

The "Select" button on the Catalog Maintenance screen is used to
select a catalog.  When you click on the "Select" button the
catalog that is currently highlighted by the blue scroll-bar will
become the currently selected catalog.  For example, to switch
from the BOOKS catalog to the PROBOOKS catalog, use the mouse to
click on "PROBOOKS" in the listing of available catalogs.  This
will move the blue scroll-bar to highlight "PROBOOKS".  Then
click on "Select" (or push ALT-S) to select the PROBBOKS catalog
and make it the current catalog.  When you leave the Catalog
Maintenance window the PROBOOKS catalog format will be displayed
on the screen.

The "OK" Button

When you have finished using the Catalog Maintenance window, and
everything is as you want it to be, click on the "OK" button. 
This will close the Catalog Maintenance window and return you to
the Main Screen.

Typing A New Entry

Information is entered into a catalog by typing it into the
appropriate fields on the Main Screen and then pushing F5 or
clicking on the "Save" button at the top of the screen.

When entering information in a catalog there are several things
to keep in mind.

Be Consistent

Be consistent in how you enter the information.  Always use
consistent capitalization.  If the words entered in a field are
capitalized, then always capitalize what you enter in that field. 
If you use abbreviations, always use the same abbreviations. 
Don't change how a word or term is abbreviated from one entry to
the next.  When you start to type in your first few entries, set
some consistent standards and then always follow those standards. 
This will make finding things in your catalog much easier.

Numbers

When entering numbers, if you want the software to put them in
the correct numerical order, always use the same number of digits
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to the left of the decimal point.  If the largest number you
expect to enter is 1000, then all numbers should be entered using
four digits.  Number one would be entered as "0001" and one
hundred and one as "0101".

Numbers do not need to have decimal points and, if they do, it
does not matter how many digits each number has to the right of
the decimal point.

Numbers and letters can be mixed together and the software can
put them in the correct alpha-numerical order, as long as the
numbers are always entered using the same number of digits.  Thus
if you have a catalog number that has a number in the middle,
such as "ART-777-X", if there is another item in which the number
in the middle is number one, it should be entered as "ART-001-X".

Dates

As with numbers, dates also need to be entered using the same
number of digits.  For example, if you enter years as 19xx, then
always include the "19".  Don't enter one date as "1966" and for
another entry type it in as "66".

In addition, always use two digits for the month and day. 
January 1st should be entered as 01/01/95.

Computers put things into alpha-numerical order starting from the
left and working through the characters from left to right.  As a
result, if you want the computer to put your catalog in order by
date so that it is in order by year, then by month for each year,
and then by day for each month, you need to enter the date with
the year first, then the month, ten the day.  For example, August
10, 1995 would be entered as 95/08/10.

If you entered dates as 08/10/95 (month, day, year) then the
computer will group the dates together first by month, then by
the day of the month. 
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THE EDIT MENU

The features on the Edit Menu are used to browse through the
catalog and make changes and corrections.  (See figure 6.)  These
features are:

Save Entry:  Saves the information for the entry currently
displayed on the screen.

Erase Screen: Clears the screen and returns you to the Main
Screen.

Delete Entry: Deletes an entry from the catalog.

Undelete Entry: Restores a deleted entry.

Copy Any Previous: This feature will copy the information from
any existing entry to the current entry displayed on the screen.

Copy Last: copies the information from the entry immediately
preceding the entry currently on the screen.

Remove Memo: memos can be attached to any entry.  This feature is
used to get rid of a memo that you wish to delete.

Memo:  Allows you to add a memo to an entry or to edit an
existing memo.

Notice that some of the options on this menu have an "F" key
designation next to them.  For those items an "F" key can be used
instead of going through the menu.  For example, the "Save Entry"
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option has "F5" to the right of it.  This means that you can push
F5 to save an entry without going through the Edit Menu.
Let's take a look at each of the features on the Edit Menu.

Save Entry

This is the first option on the Edit Menu and it does exactly
what it says.  Clicking on this menu option, or pushing ALT-S,
will save the current entry that is displayed on the screen.

You can also save the entry that is on the screen by clicking on
the "Save" button on the top of the screen.

Erase Screen

This is one of the most frequently used features in OYC. 
Clicking on "Erase Screen" (or pushing F7) will clear the screen
and reset the software back to the Main Screen.

You can also erase the screen by clicking on the "Clear" button
at the top of the screen.

Delete Entry

If you want to remove an entry from your catalog there are two
ways you can do this.  The first is to put the entry to be
removed on the screen and then type new information (a new entry)
so that it replaces the old entry you want to get rid of.

The second way is to get the entry you want to get rid of on the
screen and then click on the "Delete Entry" option on the Edit
Menu.  This will mark that entry as being deleted and it will no
longer be included in searches or listings.  For example, when
you conduct a search, even if the information in the deleted
entry matches what you are looking to find, that entry will not
be listed as a matching entry.

You can also delete an entry by pushing F4, or by clicking on the
"Delete" button at the top of the screen, when the entry to be
deleted is displayed on the screen.

Although an entry has been deleted it can still be displayed on
the screen.  For example, the "Find Deleted" option on the View
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Menu will find and display deleted entries.  When a deleted entry
is on the screen the word "Deleted" will appear in the display at
the bottom of the screen in the third box from the left.

However, a deleted entry still exists and is still part of your
catalog.  A second step is required to permanently remove it from
the catalog.  A two step process is used to give you a chance to
think about what you are doing before you permanently erase
entries from your catalog.  Your catalog will contain some very
valuable, and sometimes irreplaceable information.  It's not
uncommon, when using a computer, to delete an item.  But then, a
fraction of a second after you press the key that performs the
deletion, you realize that you've deleted the wrong item.  Should
that happen in OYC you can recover the deleted item and bring it
back into your catalog.

Once you've deleted one or more entries from a catalog, and you
are sure you want to permanently get rid of them, go to the
Utilities Menu and click on "Eliminate Deleted".

Undelete Entry

This feature brings back an entry that has been deleted.  If
you've just deleted an entry by mistake, click on this Edit Menu
option to bring it back.  You can also use some of the features
on the View Menu to find deleted entries that you may want to
bring back using the Undelete Entry feature.

For example, the "Find Deleted" option on the View Menu will find
and list all of the deleted entries in the catalog.  I'll discuss
other ways of displaying entries, including deleted entries, when
I talk about the View Menu.

Copy Any Previous

The "Copy Any Previous" feature allows you to refer
back to any previous entry you've made and copy all of the
information from that entry to the entry currently displayed on
the screen.  If you are making a new entry, the information will
be copied to the blank screen.  If you have an existing entry
display, the information will be copied to that entry so that it
replaces what was there.
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However, the new information will not be permanently saved until
you push F5 (or you select "Save Entry" on the Edit Menu, or you
click on the "Save" button at the top of the screen).  If you've
used the "Copy Any Previous" feature by mistake, and you do not
wish to loose the information in an existing entry, just push
"F7" to clear the screen.  If you are in the edit, search, or
listing modes you can also push F1 or F2 to switch to another
entry without saving the information that was copied from that
entry.

To use the "Copy Any Previous" feature click on this option on
the Edit Menu.  The screen shown in figure 7 will be displayed.
type in the number of the entry you want to copy and click on
"OK".

Copy Last

The "Copy Last" feature is one of the most frequently used.  This
feature copies all of the information from the entry that comes
just before the entry that is currently displayed on the screen.  
 
You can also use the Copy Last feature without going through the
Edit Menu by either pushing F3 or by clicking on the "Copy Last"
button at the top of the screen.

Here's how this feature is most often used:

Let's say you are entering information about several issues of a
magazine.  In this case each article in each magazine should be
cataloged as a separate entry. This allows you to enter unique
information about each article such as the arthor, subject,
title. etc.  You would do this by entering all of the information
about the magazine, such as the magazine title, publisher, issue
number, date, etc. and all of the information about the first
article in the magazine.  Then push F5 to save this first entry. 
To catalog the article start by pushing "F3" to copy the
information you just typed.  This way you only need to type in
information that has changed, such as the title of the article,
subject and author.  The information about the magazine itself
has all been copied from the first entry and need not be retyped.
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Memo and Remove Memo

The bottom two selections on the Edit Menu allow you to add a
memo to any entry or to remove a memo from an entry.

A memo can be attached to any entry in your catalog.  Memos
contain information that is typed in paragraph form.  They are
usually used for notes and comments about the entry.  For
example, when cataloging a stamp collection a memo can be used
for historical information about a stamp.

The information entered in a memo can not be searched.  For that
reason many people prefer not to use memos.  Instead they will
set up three or four long lines as a part of the catalog format.
These long lines are then used for notes and comments.  Whether
or not you use memos will depend on whether you what to include
paragraphs of text about individual items, and whether you want
to be able to use the searches to find information in the memos.

To add a memo to an entry go to the Edit Menu and click on
"Memo".  This will display the "Edit Memo" window.  You can type
paragraphs of information in the "Edit Memo" window in the same
way as you would using word processing software.  The HOME,
INSERT, DEL, etc. keys all work as they normally do in any word
processing program.  When you have completed typing the memo,
click on the "OK" button to save the memo.

If you wish to exit the "Edit Memo" window without saving the
memo, click on the "Cancel" button.  If you are editing an
existing memo, clicking on "Cancel" will return you to the Main
Screen without saving any of the changes you may have typed on
the "Edit Memo" window.  The memo will remain as it originally
was.

When an entry has a memo attached to it the word "See" (for See
Memo) will be displayed in the third box from the left at the
bottom of the screen.

If an entry has a memo attached to it that is no longer needed,
the "Remove Memo" feature on the Edit Menu is used to erase that
memo.  Start by getting the entry that has the memo to be erased
on the screen, then go to the Edit Memo and click on "Remove
Memo".  The memo will immediately be erased.  (Be sure this is
the memo you want to erase before doing this).
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THE VIEW MENU

The View Menu is used to display or print the information in your
catalog.  This is the menu used to start all searches and
listings.

First I should talk about the difference between a search and
listing.  To search means to find something.  A listing means
that all of the entries that meet a certain criteria will be
listed.  For example, if you want to find all of the books
written by the "Issac Asimov" you would search for "Asimov,
Issac" as the author.  If you want to find all of the books by
authors whose names start with the letter "A", you would search
for "A". However, if you want an alphabetical listing, by author
of your complete catalog then you are not having the computer
search for anything specific, you are just doing a listing.

Now let's talk about the features available on the View Menu (see
figure 9).  These features are:

Select Number: let's you display the information for a specific
entry number.

Previous: displays the entry that comes before the one currently
displayed on the screen.

Next: displays the entry that comes after the one currently
displayed on the screen.

List Range: This feature displays all of the entries that fall
within a range of entry numbers you specify.

List Alphabetically: gives you a complete alphabetical listing of
the entries in your catalog.

Search: is used to find specific information in your catalog.

Global Search: is used to find specific information in your
catalog without regard to which field it is entered in.

Find Deleted: finds and lists all of the deleted entries. 

Totals: calculates and displays the total value of your
collection.
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Now let's discuss each of these in detail.

Select Number (Viewing A Specific Entry Number)

Each entry in your catalog gets a unique entry number assigned to
it by the software.  These numbers are not intended to be catalog
numbers or part of the numbering system you use for your
collection.  They are only used by the computer to kept track of
what information is stored where and the sequence in which you
entered the information.  They also tell you how many total
entries you have in your catalog.

However, the entry numbers can also be used by you to browse
through your catalog.  The "Select Number" option allows you to
pick a specific entry number that you'd like to see displayed on
the screen.

To see the information stored in a specific entry click on the
"Select Number" option on the View Menu. You'll then be prompted
to enter the number for the entry you want to display.  Type the
number for the entry you want to see and push ENTER.  The
designated entry will be displayed on the screen and the software
will switch into the edit mode.  This means that you can edit the
entry that is on the screen to make any required changes or
additions.  Just type the changes you want to make and push F5 to
save the modify entry.

Previous/Next - Browsing The Catalog

You can also use the selected entry as the starting point for
browsing through your catalog.  There are two options on the Edit
Menu; one called "Previous" and another called "Next".  Clicking
on the "Next" option will display the next entry in your catalog.
Clicking on the "Previous" option will display the entry that
comes immediately before the one currently on the screen.  This
is called browsing through the catalog.

You can also see the next or previous entries without going
through the View Menu.  There are "Next" and "Previous" buttons
at the top of the screen. Clicking on these will display either
the next or previous entry.  You can also push F1 to see the
previous entry and F2 to see the next entry.
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List Range - Listing By Entry Number

Entries within a specified range of entry numbers can be
displayed on the screen or printed.  This feature is useful, for
example, if you'd like to proofread the entries you've just
typed.  If you've just type 100 entries, you can use the "List
Entries" option to print those entries so you can proofread them
and make any needed corrections.  (I find that when I read
something printed on paper I see things differently and I will
catch errors I did not see on the screen).

To list a group of entries by entry number click on the "List
Range" option on the View Menu. This will open a window that
contains prompts for the "Start #" and the "End #" (see figure
10).  Type in the entry number you want to start the listing with
and then the entry number of the last entry you want listed. 
When you press ENTER, or click on the "OK" button, the software
will then list all of the entries within the range you've
specified.  

Before trying to print a report we need to talk about something
else--setting up a report.  The "List Range" window includes a
button titled "Report Setup".  Let's talk about the features
provided by this button.

REPORT SETUP BUTTON

There are a lot of features provided by the Report Setup button
(see figure 11).  They are:

Report Destination: determines where the results of a search or
listing will be displayed.

Report format: sets some of the characteristics that effect what
a printed report will look like.

Paper options: let's you set the software so that it works with
the type of paper you have in your printer.

Page length: sets the number of lines that will be printed on
each page.
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QV Maximun number of lines: sets the maximum number of entries
that will be displayed in the Quick View mode.

QV Maximum Column Width: sets the amount of space used to display
a field on the Quick View screen.

To select the setting you want to use put the mouse cursor on the
circle next to the option you want to select and click the left
mouse button.

Report Destination

You can have the results of a search or listing displayed,
printed, or saved to a file on your disk.  The "Report
Destination" box on the Report Setup window is used to set where
the information will go.  This box includes the following
options:

Monitor: shows entries one at a time on the Main Screen.

Print: prints the entries using the currently set printed report
format.  I'll talk about printed report formats as soon as I
finish this section.

Quick View: displays the entries on the screen so that you can
see 20 entries at one time.

ASCII File: uses the currently set report format to save the
entries in a text file.  You will be given the opportunity to
enter a name of the file to be used.  The software will
automatically assign a filename extension of "TXT".

dBase File: saves the entries in a file using the dBase III file
format.  You will be given the opportunity to enter a name for
the dBase file. A filename extension of "DBF" will automatically
be added.

Paper Options 

The box in the upper right corner of the Report setup window
provides three options for the type of paper.

Continuous: This is the option that is normally used. Select this
option if you have a printer that continuously feeds paper into
the printer.  This includes laser printers.  Although laser
printers use individual sheets of paper, they automatically feed
the paper into the printer.
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Single Sheet: Select this option if your printer only accepts one
sheet of paper at a time and you need to feed each sheet into the
printer manually.

Some people have found this feature useful for printing on both
sides of the paper.  The software prints the first side of the
page, and then waits for another page to be fed into the printer. 
You then take the first page and feed it into the printer so that
the back side of the page is printed.

Labels: This option works like the continuous setting, except
that the software will not skip the page breaks.  This allows you
to print continuous feed labels in a dot-matrix printer.  Laser
printer labels should be printed using the "continuous" setting,
as laser labels work just like sheets of paper.

To change this setting put the mouse cursor on the circle next to
the setting you wish to use and click the left mouse button.

Report Options

The box in the lower left corner of the Report Setup window
provides several options that affect what your printed reports
look like. These are all features that are toggled on or off by
putting the mouse cursor on the button (that looks like a small
box) next to the feature you wish to turn on or off, then
clicking once.  When an "X" is in the button next to a feature,
that feature is on.

In previous versions of this software some people have decided
that they wanted to try all of the features, and they have turned
all of the features shown in this box on at the same time,
without regard to how their report format was designed.  Do not
just turn everything on without understanding what it does. 
While turning everything on will not hurt anything, nor will it
cause any damage to your catalog, you can get some strange
looking printed reports.

Dashed Line: When this feature is on the software will print a
dashed line between each entry that is printed.  The dashed line
serves to separate the entries and helps to make them easier to
read.
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Column Headings: Use this feature when you are printing a report
in which the information is printed in columns.  When the column
headings are turned on, the names of the fields being printed
will be listed at the top of each page.  I do not recommend using
this feature for reports that are not printed in columns.

If you are getting printed reports that have the names of the
fields in the top half of the page, and the information for a
single entry on the bottom half of the page (thus only getting
one entry printed per page), go to the Report Setup window and
turn the Column Headings off.

Lock Top Line: This is a special feature in OYC that is used to
create headings on listings.  It is generally only used with two
line report formats.

Then "No Space" option that is a part of the "Lock Top Line"
feature provides a way to add a blank line before each heading.

I'll discuss the "Lock Top Line" feature when I talk about
setting up a report format in the next section.

Sometimes, when you click on the "Report Setup" button a message
that says, "No report format selected.  Printer and file output
disabled." will be displayed.  This means that there has not yet
been a report format selected.  So let's talk about selecting and
setting up a report format.

REPORT FORMATS

Before you can print a report you need to set up a report format
to that specifies which fields to print how how they will be
arranged on the page.  The software comes with several report
formats.  If you print a report without changing any of the
settings, the software will automatically use a report format
that prints all 21 lines.  If you've set the catalog format to
have less than 21 lines, you'll probably see quite a bit of blank
space on each page.

One important point that many people get mixed about is that the
catalog format and the printed report format are two different
formats.  Most other software prints reports by taking the
information that you see on the screen and printing it in the
same arrangement on paper.  This software is different!  OYC
gives up the flexibility to arrange the information on the paper
any way you want, without regard to how it appears on the screen.
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You can include just those lines you want to have printed, you
need not print all of the information you've entered about each
item.

As far as what information is included and how it is arranged,
the catalog and reports formats are two different formats that
are not related.

You can have as many different report formats as you want, with
each one having the information arranged differently.

The "Report Maintenance" option on the Reports Menu (see figure
12) is used to create and modify report formats.  When you click
on "Report Maintenance" you will see a window that looks very
similar to the "Catalog Maintenance" window.

Report Maintenance

The "Report Maintenance" window includes the following features:

Report Format box: is used to select the report format you want
to use.

Edit: used to modify an existing report format

New: click on this button to create a new report format.

Copy: creates a new report format that is the same as the current
report format, but with a different name.  This feature is used
to setup new report formats that are similar to an existing
format.

Rename: renames the current report format.

Delete: deletes the report format and erases it from the hard
disk.

Select: click on this button to select the highlight report
format.  You can also select a report format by double clicking
on its name.

OK: closes this window and returns you to the Main Screen.

Now let's look at each of these in detail.  The "Report
Maintenance" window.
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Report Formats - Selecting A Report Format

The "Report Formats" box is used to select the report format you
want to use or edit.  To select a report format put the mouse
cursor on the name of the report format you want and then double
click.  This will select that format. 

To delete, rename, copy, or edit a report format you do not need
to select the format.  Click on the name of the format once and
the highlight bar will move to that format.  However, the
selected format, shown at the bottom of the window, will not
change.  You can then work on the highlighted format without, for
example, losing track of the format you want to use for your next
printed report.

Edit / New - Creating And Modifying Report Formats

The "Edit" and "New" features work exactly the same way and use
the same screens, with the exception that the "New" feature first
prompts you to enter a name for the new report format.

When you click on the "Edit" button the "Edit Report Format"
screen will open and the format of the currently highlighted
report format will be displayed.  If you have forgotten how a
report format is set up, this is a good way to quickly see that
format.

When you click on the "New" button you will be prompted to enter
the name you want to use for the new report format.  Type in the
name, using up to eight letters or numbers, and then either push
ENTER or click on "OK".  This will open and display the "Edit
Report Format" screen.

The name of the report format you are working on will always be
displayed in parenthesis at the top of the screen.

Looking at the controls on the "Edit Report Format" screen:

On the left is a box labeled "# Lines".  Your catalog format can
have up to 21 lines of information.  The report format reflects
that and can also have up to 21 lines.  To increase the number of
lines that will be used to print each entry click on the "up
arrow".  To decrease the number of lines click on the "down"
arrow.  The number in the box next to the up/down arrows shows
the number of lines that will be used for each item.
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Notice that as you click on the up/down arrows there is a line
that moves up and down on the screen.  In figure 14 this line is
just below the "COPYRIGHT" field. This line is used to show the
active work area, which is the area above the line.  The lines of
information that are placed in the active work area are the ones
that will be printed when you print a report.

The box at the bottom center of the screen is used to position
information on the report format. Any of the lines in the catalog
format can be positioned anywhere within the active work area.

Start by clicking on the "Name" box to display a menu that lists
all of the names in the catalog format.  Then double click on the
name of the line you want to add to report format.  Next position
the cursor in the active work area at the top of the screen, at
the spot where you would like the selected line to be printed,
and click the left mouse button.

The active work area is a representation of part of a sheet of
paper and it shows where each line will be located when it is
printed.  However, the active work area is only an approximation
of how things will look when printed.  Because, in many cases,
Windows prints using proportional fonts, the spacing may vary
slightly.  You just need to be aware that, if you've set Windows
to use a proportional font--which is almost any font except
courier--that it takes more space to print the letters "W" and
"M" than it does for the letters "i" or "l".  Thus, if the
information being printed has a lot of M's or W's, that may
effect the end result you see on the paper.  This is not
something you need to worry about, but it is something you need
to be aware of.

When you put a line on the report format the name of that line
will appear at the spot where you have set it to be printed--
although in some cases only part of the name will appear.  The
software approximates the amount of space that will be used to
print the average information that might be in your catalog, and
displays the name of the line using that amount of space. 
However, if this is a short name or a short line (which, as a
result, uses little space), only part of the line name will
appear.

The number of characters to be printed can be reduced to a number
that is less than the number of characters in that line in the
catalog format.  For example, let's suppose that your catalog



__________________ORGANIZE! Your Collection In Windows - 32

format has a SUBJECT line that has 40 characters.  However,
when you print a report you want to save paper by printing the
information from several catalog lines on a single line in the
printed report.  If you feel that the first 20 characters of the
subject line is enough for you to know what the item is, you can
decrease the length of the SUBJECT line so that only the
first 20 characters are printed.  This has no effect on the
catalog format, where the SUBJECT line stays at 40 characters. It
only effects the number of characters that will be used to print
the information on the description line.

The "Width" control (see figure 15) is used to adjust the number
of characters that will be used in the printed report.  Clicking
on the down arrow decreases the number of characters that will be
printed. Clicking on the up arrow increases the number of
characters.  However, the number of characters can not be
increased above the length of the line in the catalog format.

You can have information from more than one line printed on a
single line in a report.  However, you must have at least one
blank space between each item.  The software will not allow you
to place lines on the report format so that they run together or
overlap each other.

Once a line is placed on the report format it can be moved around
in several ways.  For example, you can use the mouse to click on
the line you want to relocate.  (That will turn the background
for that line black).  Then put the cursor at the new position
for the line and click the left mouse button.  There is also a
set of four arrow buttons located just above the "Remove" button. 
Clicking on any of these will move the selected line by one space
in the direction of the arrow.  You can not, however, use these
buttons to move a line into an invalid location--for example, a
location that is already occupied by another line.

The "Remove" button is used to remove a line from the report
format.  First click on the line you want to remove so that it is
highlighted in black, then click on the "Remove" button.

You can create report formats that are up to 256 characters wide. 
However, most printers can not print that many characters across
the width of a page.  You need to be aware of how many characters
your printer can fit on a single line.  And keep in mind that
this number will vary depending on which font you are using and
whether you are printing in landscape or portrait mode (on a
laser printer).  A general rule of thumb is that when using a 12
point courier font, you can get 80 characters per line.
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A column and row display in the center box shows the position of
the currently selected line.  This can be used to help you
determine whether all of the lines on your report format will fit
within the available width of the paper.

If, when setting up a report format, you want to place lines in
columns that are off the right edge of the screen, use the
"Scroll Page" arrows to shift the screen to the left.  Using the
"Scroll Page" arrows you have access to the full 256 columns that
can be printed.

The final option on the "Edit Report Format" screen is the "Show
Titles" option.  You have the option of either having the line
title printed as a part of the report format, or just having the
information printed with no title.  For example, if this option
is active, then a line titled "SUBJECT" would first print the
word "SUBJECT", then a colon, and then the information on the
subject line.

When line titles are printed an additional 16 characters is added
to the space used to print each line.

Once you have the report format set up the way you want it to be,
click on the "OK" button to save the format and return to the
"Report Maintenance" screen.

Copying Report Formats

Should you be setting up a new report format that is very similar
to an existing format, you can copy that existing format and use
it as the starting point for the new format.  To copy a report
format first click (once) on the name of the format you want to
copy. This will move the blue highlight bar to that name.  Then
click on the "Copy" button.  The dialog box shown in figure 17
will appear.  Type in the name you want to use for the new
format; and then push ENTER or click on the "OK" button.

Rename A Report Format

If you'd like to change the name of a report format, first click
(once) on the name of the format to be renamed.  This will move
the blue highlight bar to that name.  Then click on the "Rename"
button and enter the new name for this format. Push ENTER, or
click on OK, and the format will be renamed.
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Deleting Report Formats

To get rid of a report format, and erase it from the disk, click
(once) on the name of the report format to be erased so that the
blue highlight bar moves to that format.  Then click on the
"Delete" button.  The software will ask you if you are sure you
want to erase this format. Click on "OK" and the format will be
erased.

Now let's return to the View Menu and continue covering the menu
options on that menu.  We've already talked about listing a group
of entries based on their entry numbers, so let's go on to the
next option on the View Menu, List Alphabetically.

VIEW MENU - List Alphabetically

The "List Alphabetically" option provides a way to list either
your entire catalog, or a selected portion of it, in alphabetical
order.  To produce an alphabetical listing the line that will be
alphabetized must have a key symbol on it indicating that it is
indexed.

When you click on the "List Alphabetically" option on the View
Menu the "List Alphabetically" window will be displayed.  The
first step is to select the field that will be alphabetized. 
Click on the "Key Field" box to see a menu listing all of the
index fields. Then click on the field you want listed
alphabetically.

If you need to change the settings on the "Report Setup" window,
click on the "Report Setup" button.  You would do this, for
example, if you had been listing information on the Quick View
screen and you now wanted to reset the software to produce a
printed report.

If you want an alphabetical listing of your complete catalog,
click on "OK" and the software will start the listing.  If you
want to limit the entries that will be listed to a specified
range, you can set both a starting point and an ending point.

To set a starting point click on the "Set Start" button.  This
will display the "Setup Alpha Starting Point" screen.  You can
enter starting point criteria for any of the lines in your
catalog.  However, the information you enter to designate the
starting point must match an existing entry.  If it does not you
will get a "No matches found" message when you start the listing.
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I recommend keeping things as simple as possible when setting a
starting point.  Keep in mind that the more information you
enter, the more chances there are for a typo.  You should
generally only enter information on the line being listed
alphabetically.  However, if you need to you can enter
information in other fields and the software will automatically
cross reference to find the matching entry that will be the
starting point of the listing.

The ending point is set in the same way using the "Set End"
button.

You can set either a starting point or an ending point without
setting the other.  For example, setting a starting point, but no
ending point, will start the listing with the designated entry
and list the catalog from that point to the end.

VIEW MENU - Searches

The searches are used to find things in your catalog.  To start a
search click on the "Search" option on the View Menu.  This will
display the "Search" window.

There are two type of searches: alphabetical and sequential.  The
alphabetical search uses the indexes to quickly find and jump to
the matching entries.  An alphabetical search works just like
using an index in a book to find something.  You can look in the
index, find what you want, and go directly to the age containing
the information you want.

A sequential search, on the other hand, works like reading a
book.  One way to find the information you need in a book is to
start reading the book from the beginning and keep reading until
you come to the information you want.  Reading a book, from the
beginning, takes a lot more time than just looking in the index
and going directly to the page you need.  But it does have
advantages (otherwise, why would we bother reading books?).  For
example, an index does not contain a listing of all of the
information in the book. The index just lists the "key" topics. 
There's a lot more in the book than just what is listed in the
index.  By reading the book you can find information that may not
be listed in the index.
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Computers work in exactly the same as I've described for books. 
The alphabetical searches use the indexes to quickly find the
desired information.  The sequential searches start at the
beginning of the catalog, and read through the entire catalog
looking for and identifying entries that have the information you
want.  While sequential searches are slower, they can do things
that alphabetical searches can not, such as find information
within a line.  Alphabetical searches can only find exact matches
of information, starting on the left end of the field.

Let's start by seeing dow to do a sequential search.

Sequential Searches

The Search Window has a box in the upper left corner that is used
to select either an alphabetical or a sequential search.  Click
on the circle next to the word "Sequentially" to set the software
to use a sequential search.

Next you need to tell the computer what you want it to find. 
Click on the "Search Setup" button.  This will display the "Setup
Search Criteria" window (see figure 20).  All you do is type in
the information you want to find, in the same field where it is
located in your catalog.  You can enter information on multiple
fields and the software will automatically cross reference the
information you've entered and find just those entries that match
all parts of the search criteria.  You can enter information you
want to find in one field, or in all of the fields.  However, I
suggest keeping the search criteria as simple as possible.  The
more complex you make it, the more fields on which you enter
something to search for, the more likely it is that there will be
a typo.

You do not need to enter complete words or phrases as the search
criteria.  For example, if you are searching for the name "Paul
Stephanopolis", but can't remember how to spell it, just search
for "Paul Ste".

You can also search for letters, words, or phrases that are
contained within the information in a field.  For example,
searching for "Red" will find "Redbird", "Robert Redford", and
"Red Roses For A Blue Lady."

Once you have entered the criteria that identifies what you want
to find, click on the "OK" button.  This will return you to the
search window.
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If you have not already selected a report type, click on the
"Report Setup" button.  You can now set the report to be printed,
saved in an ASCII file on the disk, listed on the Quick View
screen, etc.  I generally find the Quick View screen to be the
most convenient way to look at the results of a search or
listing.  It lists 19 entries at a time on the screen, and it's
easy to scroll through the list.  I'll be discussing the Quick
View screen shortly.

The settings on the Report Setup screen are retained from one
search to the next.  Once you have set them, you do not need to
set them again unless you need to make a change.  The settings
will go back to their defaults anytime you use a different
catalog or when you exit from the software.

There is one additional setting to look at before starting the
search.  The software can be set to do searches in either a case
sensitive mode or case insensitive mode.  When doing case
sensitive searches the capitalization of the search criteria must
exactly match that of the information in the catalog.  When set
to case insensitive, the capitalization does not matter.

The case sensitive/insensitive setting is set by clicking on the
box next to the words "Case Sensitive".  When there is an "x" in
the box the searches will be case sensitive.

It might seem that you would want all searches to always be case
insensitive. That way you wouldn't need to worry about whether a
word is capitalized or not.  However, there are some very
important uses for case sensitive searches.  For example, using
the example of searching for "Red"; if you wanted to find all
people whose names start with "Red" then you should run a case
sensitive search.  That way the search would just find "Redford"
and "Redmond", and would ignore "Fredrickson" and "Predwell".

To start the search click on the "OK" button.

Alphabetical Searches

To run a search in which the matching entries are listed in
alphabetical order, start by selecting "Search" on the View Menu. 
The "Search" window will appear.  Click on the circular button
next to "Alphabetically".



__________________ORGANIZE! Your Collection In Windows - 38

As with the sequential searches, if you have not already done so,
you should click on the "Report Setup" button to set these
options.

Next click on the "Search Setup" and enter the search criteria. 
This is done in the same way as for the sequential search.

The main difference between the alphabetical searches and the
sequential searches is that the buttons in the "Alpha Setup" box
can now be used (see figure 21).

Start by clicking on the "Key Field" box.  This will display a
menu of showing the fields that are indexed.  Click on the name
of the field that you want to use to set the alphabetical order.

If you want the search to include your complete catalog, click on
"OK" and the software will start the listing.  If you want to
limit the entries that will be searched to a specified range, you
can set both a starting point and an ending point.

To set a starting point click on the "Set Start" button.  This
will display the "Setup Alpha Starting Point" screen.  You can
enter starting point criteria for any of the lines in your
catalog.  However, the information you enter to designate the
starting point must match an existing entry.  If it does not you
will get a "No matches found" message when you start the search.

I recommend keeping things as simple as possible when setting a
starting point.  Keep in mind that the more information you
enter, the more chances there are for a typo.  You should
generally only enter information on one or two fields.  However,
if you need to you can enter information in, other fields and the
software will automatically cross reference to find the matching
entry that will be the starting point of the search.

The ending point is set in the same way using the "Set End"
button.

You can set either a starting point, or an ending point, without
setting the other.  For example, setting a starting point, but no
ending point, will start the search with the designated entry and
list the catalog from that point to the end.

To start the search click on the "OK" button.
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Global Search

The sequential and alphabetical searches I've described so far
only search the fields in which search criteria is entered.  If
you entered a name to search for in the AUTHOR field, the search
will only find those entries that have that name in that specific
field.  But what if you want to find something that might be
included in any of the fields.  For example, you might want to
search for "Issac Asimov" and find all the books and magazine
articles he has wriiten, edited or which have been written about
him.  You could do this with three separate searches, by
searching the author, editor, and subject fields one at a time. 
Or you can use a global search.

A global search will find entries that contain information that
matches the search criteria, without regard to which field
contains that information.

To start a global search click on "Global Search" on the View
Menu.  This will display the Global Search window (see figure
22).  There is only one setting on this window, the toggle for
the "Case Sensitive" setting.  Like the other types of searches,
you can set global searches to be either case sensitive or case
insensitive.

Start thee global search by typing the information you want to
find. This can be a single character, an abbreviation, a word, or
a phrase.  Remember, if the search is set to be case sensitive,
the capitalization of what you type here as the search criteria
must exactly match the way it is entered in your catalog.

Once the search criteria is entered, click on the "OK" button to
start the search.

Finding Deleted Entries

<<This feature is not available in this shareware version.  IT is
provided in the registered version.>>

When an entry is deleted from the catalog using the "Delete
Entry" option on the Edit Menu, it is not physically removed from
the catalog.  What happens is that the entry is marked as being
deleted and all searches and listings will treat that entry as if
it does not exist.  However, there may come a time when you want
to recover a deleted entry--possibly it was deleted by mistake. 
But since the searches and listing no longer recognize it as a
valid entry, there is no way to find it--especially if you have a
large catalog.  This is where the "Find Deleted" option is handy.
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Clicking on the "Find Deleted" option on the View Menu will list
all of the deleted entries in the catalog.  Before doing this be
sure the software is set for the report mode you want to use. 
For example, if you want to look at the deleted entries using the
Quick View screen, use the "Setup" option on the Reports Menu to
set the software to use the Quick View screen.

Getting Total Values

The final option on the View Menu is called "Totals".  This
option provides a quick way to see the total value of your
collection.  Just click on "Totals" and the software will display
the total amount entered in all fields that are marked to be
totaled.  For example, if you have a VALUE field, this feature
will go through your catalog and add up the amount entered in
that field for each entry, and then display the total.

Quick View

I've mentioned the Quick View screen several times.  The Quick
View screen provides a way to see 19 entries on a single screen
(see figure 23).  The information for each entry is listed
horizontally on the screen.  A slider along the bottom of the
Quick View screen allows you to move the display left and right,
and thus see all of the fields.

The slider on the right edge of the Quick View screen let's you
move the display up and down to see additional entries.

Entries can be edited right on the Quick View screen.  To make a
change use the mouse cursor to click on the field you want to
change.  That field will then be placed into an edit box (the
outline around the field becomes bold).  You can then edit the
contents of that field and the changes will automatically be
saved.

The top of the Quick View screen will always display the column
headings that identify the fields.  These headings are shown on a
grey background.  The entry number is shown on a grey background
on the left edge of the screen.

UTILITIES MENU

The Utilities Menu has six options (see figure 24).  These are:
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Reindex: creates all new indexes for all fields marked with a
"key" symbol.

Sort: puts the catalog into alpha-numerical order based on the
information in several fields.

Copy Entries: copies entries from one catalog to another.

Eliminate Deleted: permanently removes deleted entries from the
catalog and recovers the space used by the deleted entries.

Set Security Code: is used to set up a security code that limits
access to your catalogs.

Setup Macro:  A macro provides a way to use a single ALT-key
combination to enter a full line of information. This option on
the Utilities Menu is used enter the information the macro ALT-
keys display.

Now let's take a look at each of these in more detail.

Re-indexing A Catalog

As we've already discussed, the indexes are used to put the
catalog into alphabetical order.  The reindex feature is used
anytime you need to have the software take all of the information
in your catalog and put it into an index.  Normally entries in a
catalog are entered into the indexes as you type them.  You do
not need to reindex just because you've added some information to
a catalog.  However, if you already have some entries in a
catalog, and you then turn on the indexing for a field, the
existing entries will not be in the index for that field.  This
is when you need to run the "Reindex" feature to put all the
existing entries into the new index.

Another circumstance that results in having to reindex a catalog
is when files get damaged.  While the catalog is a very difficult
file to damage, the indexes are very fragile.  They maintain
information that is both large and complex, and which can be
damaged by things such as fragmented or cross-linked files. 
Should it seem that the software is having trouble with listing
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entries in the correct alphabetical order, running the Reindex
feature will usually clear up the problem.

Re-indexing is simple and straight-forward.  Click on the
"Reindex" option on the Utilities Menu and the re-indexing is
automatically taken care of by the software.

Multiple-Level Sorting

Sorting, like indexing, also puts the entries in your catalog
into alphabetical order.  However, unlike indexing, which handles
each field individually, sorting can base the alphabetical order
on several fields.  With books, for example, you might use the
sort feature to put your catalog into alphabetical order by
subject, and then for each subject have all of the titles listed
alphabetically.  

To sort your catalog click on the "Sort" option on the Utilities
Menu.  This will display the "Sort Setup" window (see figure 25). 
This window is used to set the order in which you want your
catalog sorted.  The main part of this window will initially be
blank.  On the left side of the lower portion of the window is a
drop-down list-box that lists the fields in the catalog.  Use
this list-box to select the first field to be alphabetized. Then
click on the "add" button to add it to the list of fields to be
sorted. Then select the next field to be alphabetized.

Although the software can handle more, I recommend that you not
sort more than four fields.  Anything more than that just uses up
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a lot time in getting the sorting done, and any fields after the
fourth have little effect on the final sorted order.

If you need to change the order in which you have selected
fields, the "Remove" button will remove the field listed lowest
on the diagram.  Or you can click on the "Clear All" button to
clear all of the fields and start over again.  The "Clear All"
button also clears any previous sort order the catalog might be
in, instantly returning the catalog to its original unsorted
order.

Once you've selected the fields to be used for sorting, click on
the "OK" button to start the sorting.  The software will run
through the fields, in reverse order, indexing and then sorting
the catalog into the proper order.

When you want to list the catalog in the sorted order, start an
alphabetical listing based on the first field selected for the
sorted order.  That field will need to have a "key" symbol to
show that it is indexed.  None of the other fields need to be
indexed.

Copying Entries From One Catalog To Another

<<This feature is not available in this shareware version.  It is
available in the registered version.  A utility for copying
entries is available on the ORGANIZE! Everything... BBS by
calling 1-503-692-0382.>>

The "Copy Entries" feature on the Utilities Menu was designed so
that you can enter information using one computer (or have
several people working on several computers simultaneously--
keeping in mind that you must have a site license for you
software, if you are doing this) and then copy those entries into
a main catalog file on another computer.  For example, I like to
work on cataloging my collection while watching television. I use
a laptop computer to type new entries.  When I'm done I copy that
catalog files (the files that end with DAT and SET) to a floppy
disk in my laptop.  Then I copy the catalog files from the floppy
disk to the hard disk in my desktop computer.  To add the new
entries to my existing catalog I use the "Copy Entries" feature
on the Utilities Menu to copy the entries from the new catalog to
my existing catalog..

There are two things to keep in mind when doing this.  Always
start with a blank catalog when typing the new entries on the
second computer.  Otherwise each time you copy the entries to the
main catalog you will be creating addition copies of entries that
are already in the main catalog.  You don't want to copy the same
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entries to the main catalog twice.  And remember that in order to
use software on two computers, you need to have purchased two
copies of the software or you need a site license.  HomeCraft
gives you, with the purchase of this software, a personal site
license that allows you to install the software on one additional
computer for personal use only. This allows you to legally use
this single copy of the software on another computer as long as
the software can not be used simultaneously by two people.  (See
the license in the front of this manual for specific details).

Here's how the "Copy Entries" feature works:

Click on "Copy Entries" on the Utilities Menu.  This will open a
window titled "Enter Source/Destination."  This window is used to
select the catalog you want to copy from (source) and the one to
which the entries will be copied (destination).  Drop-down list
boxes are used for selecting each catalog.  Once you have
selected each catalog click on the "OK" button.

You'll now see the "Configure Copy" window (see figure 27).  You
can use this window to rearrange the order of the fields.

To rearrange then click on the circle next to the line where you
want to put a different field.  Then click on the drop-down list
box at the bottom of the screen.  This will display a list of the
field names. Click on the name of the field you want positioned
where the "dot" is located.  The field currently on the line with
the "dot" will be swapped with the field selected in the drop-
down list box.

Click on "OK" to start copying.

To copy a catalog the software goes through the complete catalog
and copies each entry individually.  This allows the contents of
one catalog to be added to another catalog.  However, copying
large catalogs may take awhile.

Eliminate Deleted

When the "Delete Entry" option on the Edit Menu is used to delete
an entry from the catalog, the entry is not completely removed
from the catalog. It has only been marked as deleted and the
searches and listings no longer recognize it as a valid entry. 
However, that entry still exists and it can be recovered using
the "Undelete Entry" feature.
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When you are sure that you want to get rid of the deleted entries
in your catalog, the "Eliminate Deleted" feature is used to
completely remove them from the catalog and recover the space
they were using.

Start by clicking on the "Eliminate Deleted" option on the
Utilities Menu.  You will be asked whether you are sure you want
to do this. Click on the "OK" button if you want to proceed. The
software will then go through the entire catalog and permanently
remove all the deleted entries.

Set Security Code

The ORGANIZE! software provides a three-level security system. 
However, few people actually need to use the security features. 
I mention this because some people feel that if a feature is in
the software, then it must be something they should be using. 
This is not the case with the security feature.

The purpose of the security feature is so the software can be
used in places where a large number of people have access to a
catalog, but you want to prevent them from changing the
information in the catalog.  They can look things up, but not
modify them.  Only the people who have the security code, that
allows full access, have the ability to make new entries and
modify existing entries.  This type of situation typically exists
in a library, at a club meeting, or in a business. Any place
where you might want to allow people to have access to a catalog,
but you don't want them to be able to change anything.

The three security levels are:

Level 1 - provides access only to people who know the three digit
access code.

Level 2 - provides full access to anyone who knows the correct
security code and read-only access to everyone else.  With
read-only access you can look up and read any of the entries, but
you can not modify entries.  With read-only access, some
selections on the drop-down menus (ones that would have allowed
changes to be made) no longer appear on the menu. 

An example of where level 2 security might be used is in a
library.  In that case only the librarian has the security code 
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that allows changes to be made.  Patrons of the library have
read-only access for looking up books and magazines.

Level 3 - allows full access to anyone, eliminating the need to
enter a security code.

To set a security code, select the "Set Security Code" option on
the Utilities menu.  You will then be prompted to enter a three-
digit security code.  If you enter a number between 001 and 250
the software will run at level one security.  You will need to
enter the correct security code number before getting access to
the software.

Entering a number from 251 to 500 provides level 2 security.  If
you enter the correct code you have full access.  Entering any
other number provides read-only access.  Users can look at the
information in the catalogs, but they can not change anything.

Setting the security code to any number greater than 500 allows
full, level 3, access to everyone.

If you've set a security code that is 500 or lower, when the
software first boots, a dialog box will appear and request that
you enter the security code.  The correct security code must be
entered.

The security code is stored in the HOMECRAF.SET file.  If this
file should be erased, you will not be able to use the software. 
You will need to either replace the HOMECRAF.SET file using a
backup copy or from your original disk, or use the RESET.EXE
utility to create a new copy of this file.

Another problem you might run into is forgetting your security
code.  Should this happen you can still get into the software. 
On the original floppy disk we have provided a program called
RESET.EXE.  This utility serves as a "skeleton" key that will
reset the security code to allow full access.  To use RESET, copy
it to the same disk and directory that has the ORGANIZE!
software.  Get the DOS prompt on the screen for the directory
containing ORGANIZE!, type RESET and push ENTER.  The security
code will automatically be reset.  This utility also resets all
the other settings to their original defaults.

If you are using the security feature, be sure to put any disks
containing RESET.EXE away in a safe place.
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Setup Macros

The last option on the Utility Menu is "Setup Macro".  A macro is
a way to enter a complete line of information using a single ALT-
key combination.  Macros are very useful, and time saving, when
you need to frequently type in the same information for a large
number of entries.  For example, if you are cataloging books on
geography, you can set up ALT-key combinations that quickly enter
the name of a country.  The ALT-A combination can be set to enter
the word "AUSTRALIA"; ALT-B can be set to enter BRAZIL; and ALT-C
can be set to enter "CANADA".  With macros setup for each country
in your collection you'll never need to type out the complete
name of a country again.

You can set up as many 30 different macros.  Start by clicking on
"Setup Macro" on the Utility Menu.  This will display the "Edit
Macro" window (see figure 28).

A drop-down list-box shows all of the ALT-key combinations that
are available to be set up as macros.  Both letters and numbers
can be combined with the ALT-key and be setup as a macro. 
However, not every letter can be used.  Some of the ALT-letter
combinations are used to pull down menus on the Main Screen.  For
example, ALT-E displays the Edit Menu and ALT-F displays the File
Menu.

To set up a macro use the drop-down list-box to select the ALT-
key combination you want to use for the macro.  Then type in the
text you want to assign to that ALT-key combination.  Set up (or
edit) all of the macros then click on the "Save" button.

To leave the "Edit Macro" window click on the "OK" button.

To use a macro put the cursor in the field where you want to type
in the information contained in the macro and push the ALT-key
combination.  For example, if you set up ALT-A as "AUSTRALIA", to
enter "AUSTRALIA" in a field on the Main Screen, put the cursor
in the COUNTRY field (on the Main Screen), hold down the ALT key
and push the letter "A".

You can use a macro to put information anywhere in a field, it
does not have to be placed at the left side of the field.  You
can even insert the information in a macro into the middle of a
word.
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SECTION THREE
STEP-BY-STEP
The following is a step-by-step giude to using the key features
in the ORGANIZE! Your Collection For Windows software.

Using Different Catalogs

To switch the software to use a different catalog, start by
pulling down the Files Menu by clicking on "Files" in the upper
left corner of the screen.  Next click on "Catalog Maintenance".

The "Catalog Maintenance" window is used to select the catalog
you want to use.  Catalogs can be on any drive and in any
directory.  The boxes on the left side of the "Catalog
Maintenance" window are used to select the catalog you want to
use.

If you see the name of the catalog you want displayed in the
"Catalogs" box in the lower left part of the window, use the
mouse cursor to double-click on that name.  Then click on the
"OK" button to return to the Main Screen.

The list of catalog names is shown in alphabetical order.  If you
do not see the catalog you want to use, it may be on a part of
the list that is not shown.  If the list is too long to fit in
the box, there will be a slider control on the right side of the
box.  Use the mouse to move the slider up or down (or click on
the up/down arrows at the top and bottom of the slider) until you
see the catalog you want.  Then double click on that catalog to
select it, and click on the "OK" button to return to the Main
Screen.

If the catalog you want to use is in another directory, or on a
different disk drive, you'll need to use the box in the upper
left corner of the window to first select the drive and path 
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where the catalog is located.  Start by clicking on the drop-down
list box at the top of the screen to display a list of disk
drives.  Click on the disk drive that has the catalog you want to
use.

Now use the box below the disk drive drop-down list-box, to
select the directory containing the catalog you want.  If the
directory is not shown, click on the top item, which should be
just the drive letter, a colon, and a back slash.  This will
select the root directory and you should then see a listing of
all the directories on that drive.  Once you have selected the
correct directory, you can select the catalog as described above.

Printing A Report - Alphabetical Listing

The ORGANIZE! software can print an alphabetical listing based on
the information in any of the fields in your catalog.  To do
this, follow these steps:

1) Pull down the View Menu and click on the "List Alphabetically"
option.

2) In the "List Alphabetically" window click on the "Key Field"
drop-down list-box. This will display a list of the fields that
are alphabetized.  Click on the field you want listed
alphabetically.

3) Click on the "Report Setup" button.  Then click on the
circular button next to "Printer" in the Report Destination box. 
The black dot should move to the button next to the word
"Printer".

4) Check the "Report Format" box in the lower left section of
this window to be sure the dashed line, column headings, and lock
top line are all set the way you want them to be.

5) Click on "OK" to leave the "Report Setup" window.  Then click
on "OK" in the "List Alphabetically" window.

NOTE: You also need to have already setup a report format.
Setting up a report format means that you have told the computer
how you want the information arranged on the page when it is
printed.  The "Report Maintenance" option on the Reports Menu is
used to design, select, and setup report formats.
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6) The next window allows you to enter a title for your report. 
This title will be printed at the top of the first page of the
report.  The title can be used for things such as to identify
what the report is showing; the date of the report; the reason
for the report, etc.  If you do not want to put a title on the
report, click on the "Cancel" button.

The software will now start to print the report using the print
options and fonts selected in Window's Print Manager.  Depending
on your computer, it may take a few minutes for your printer to
start, as sometimes Windows is a little slow in getting documents
printed.

Printing A Report - Searching

When you want to find something specific, and print a list of all
the entries that have what you are looking for, it is called a
search.  This is how to search for something in your catalog and
print the results of the search:

1) Click on "View" to display the View Menu.  Then click on
"Search".

2) In the "Search" window click on "Sequentially".

3) Click on the "Report Setup" button.  And then set the report
destination to be the printer by clicking on "Printer" (see
figure 30).  Check to be sure the paper options and the items in
the report format box are set the way you want them.  Then click
on "OK".  This returns you to the "search" window.

4) Check to be sure the "Case Sensitive" setting is the way you
want it to be.

5) Click on the "Search Setup" button.

6) Type the information you want to find in the fields were it
you expect to find it.  For example, if you are looking for all
of the books by a specific author, type that person's name in the
author field.  You can enter information on multiple fields.  For
example, with books you might enter a name on the author line,
and a word or phrase--such as "American History" on the subject
line.  The software will automatically cross-reference what
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you've entered as the search criteria and list all books, by the
author you've specified, that are about American history.

Now click on the "OK" button on the "Setup Search Criteria"
window. This will return you to the "Search" window.

7) Click on "OK".  

8) The next prompt gives you an opportunity to put a title on the
first page of your report.  If you do not want to have a title,
click on the "Cancel" button.  Otherwise you can type a title
that is up to one line in length, and that will be printed at the
top of the first page.

Another Way To Search

You can run searches that are printed in alphabetical order based
on a field other than one of the fields included as a part of the
search criteria.  Do everything the same as described in the
previous section.  Before step 7 add the following steps:

6a. Click on "Alphabetically" to switch the software to do an
alphabetical search.

6b. In the "Alpha-Setup" box click on the "Key Field" drop-down
list-box.  Select the field you want to use for setting the
alphabetical order by clicking on its name.  This does not need
to be a field that is included as a part of the search.

6c. Click on "OK" to start the search.

Here's an example using a music collection:

Let's say that you want to find all the books you have by a
certain author, and you want them listed alphabetically by book
title.  Enter the name of the author, in the AUTHOR field, in the
"Setup Search Criteria" window.

Then, in the "Alpha-Setup" box set the key field to "BOOK TITLE". 
Be sure the software is set to do an alphabetical search and then
click on "OK" to start the search.
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Entering Similar Entries

If you are entering information about a lot of similar items, you
can save a lot of keystrokes by using the "Copy Last" feature.

1) Type in the first item in the series.  This might be the first
song on an album; the first issue of a magazine or comic book;
the first in a series of video tapes; etc.

2) Push F5 (or click on the "Save" button at the top of the
screen) to save this first entry.  A blank screen, ready for the
next entry will be displayed.

3) Push F3 (or click on the "Copy Last" button at the top of the
screen).  This will copy the information you just entered to the
new entry.

4) Change the information that is different from the previous
entry and push F5 (or click on "Save") to save this entry.

5) Repeat steps 3 and 4 until you have finished the series of
items.

Using The Lock Top Line Feature

The Lock Top Line feature is used to put headings on sections of
a printed report.  To use the Lock Top Line feature you need to
set up a report format that has just two lines.  The top line of
the report format should contain the information you want to
"lock" in place as a heading.  The second line should have all of
the other information you want to print.

Let's look at an example using a video tape collection.  Let's
say you wanted to list all of your movies in alphabetical order
by the major star.  Start by setting up a report format that has
just the star's name on the top line. On the second line of the
report format put the name of the movie, the year, and the time
(or whatever other information you are interested in printing).

Use the "List Alphabetically" feature to start an alphabetical
listing by STAR.  Be sure that the "Lock Top Line" feature, on
the "Report Setup" window, is turned on. (There should be an "x"
in the box next to "Lock Top Line".
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The resulting printed report will look like:

DELANY, SAMUEL R.
    Fall Of The Towers, the    SF0023
    Towers Of Toron, the       SF0024

HEINLEIN, ROBERT A.
    Moon Is A Harsh Mistress   SF1055
    Past Through Tomorrow, the SF1056
    Stranger In A Strange Land SF1057

SIMAK, CLIFFORD D. 
    Cosmic Engineers           SF0004
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APPENDIX A
Problem Solving

This appendix talks about things you can do should you run into a
problem with using OYC.

Back Up Your Catalog

I can't say it enough times--back up your catalog on a regular
basis.  The rule ofthumb you should follow is that your catalog
should be backed up any time you've typed more new enytries (or
editor more existing entries) than you'd want to type again.  For
some people this is 40-50 entries. For others it might be 100-150
entries.  Always keep in mind that things happen in computers
that can result in your catalog file being damaged or lost--in
particular if you are using software that doubles the space on
your hard disk.  The best way to be protected to to have multiple
backup copies of your catalog.

OYC includes a backup utility that can be used to backup small
catalogs.  The size of the catalog you can backup with the OYC
utility depends on how much information you've entered in your
catalog, and the number of fields in the catalog.

If OYC can no longer fit a backup onto a single floppy disk, you
will need to use a more powerful backup utility.  DOS Six
includes a fair backup utility, but you should really get a
program such as PC Tools, Fastback, or Hard-Back.

Out Of Memory Errors

Should Windows repeatedly display a "Not Enough Memory" message,
you will need to make some changes in how you use your computer. 
Keep in mind that each program you are running requires memory
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space.  If you have several programs running, try closing some of
them.  If you are using a word processor or sreadsheet, close
some of the documents or spreadsheets.

Using programs whose icons are in different program groups will
also use up extra memory.  Put all of the programs you most
frequently use in the samen program group.

General Protection Fault

A General Protection Fault happens when the software trys to use
memory that has not been allocated to the software.  Essentially
what this means is that the computer no longer has enough
resources left to do what you are telling it to do.  Try closing
all of the applications that are running and rebooting your
computer.  Restarting Windows is the best way to clear up this
problem.  If you do not restart Windows you will continue to get
General Protection Fault error messages.

You should also check for cross-linked files and/or fragmented
files.  These types of errors can corrupt a file with the result
that a General Protection Error is caused.

Another thing you can try is to start a program called
DRWATSON.EXE.  This program is in your Windows directory.  Once
DRWATSON.EXE is running, if you run into a General Protection
Error (or any other type of error) information about what
happened will be stored in a file called DRWATSON.LOG.  You can
then read this file to get a better understanding of what
happened.




